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Overview

The management server lets you obtain the latest information about your applications, such as
Microsoft Exchange and Oracle. To determine which applications the management server
supports, see the support matrix, which is accessible from the Documentation Center. The
following features help you to easily obtain data about these applications so you can quickly react
to changes in your networking environment. For more information about these features, see the
user guide.

Application Viewer — Lets you quickly obtain information about the applications in your
network. It provides a quick snapshot of the number of applications the management server is
monitoring and their events.

Report Optimizer — Lets you obtain reports about an application. You can schedule these
reports to be emailed to others on a regular basis.

System Manager — Provides a graphical representation of the applications the management
server is monitoring.

Properties Tab — Provides detailed property information about your application.
Topology Tab — Lets you view the components of your application.
Chargeback Manager — Lets you determine how much it costs to run an application.

Policy Manager — Lets you create policies that notify you when a certain amount of free
space goes below a threshold or the percentage used goes above a threshold.
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Accessing Information About

Applications

This chapter contains the following topics:

About Application Viewer below

Obtaining a Summary of the Applications on next page
Navigation Information for Applications on page 13
Events for Applications on page 14

Viewing Performance Information on page 16

About Chargeback for Applications on page 16

About Application Viewer

Note: Depending on your license, Application Viewer may not be available. See the List of
Features to determine if you have access to Application Viewer. The List of Features is
accessible from the Documentation Center (Help > Documentation Center).

o

Access Application Viewer by clicking Application Viewer (™).

Application Viewer lists the applications and their instances running in the storage area network
(SAN) and any events associated with them. Application Viewer also provides the following
information for applications:

Microsoft Exchange — Data pertaining to navigation, properties, topology, chargeback,
reports, monitoring, and policies.

Oracle — Data pertaining to navigation, properties, topology, chargeback, reports, monitoring,
and policies.

Microsoft SQL Server — Data pertaining to navigation, properties, topology, chargeback,
reports, monitoring, and policies.

Sybase — Data pertaining to navigation, properties, topology, chargeback, reports,
monitoring, and policies.

Caché — Data pertaining to navigation, properties, topology, chargeback, reports, monitoring,
and policies.

DB2 - Data pertaining to navigation, properties, topology, chargeback, reports, monitoring,
and policies.
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Chapter 2

o Informix — Data pertaining to navigation, properties, topology, chargeback, reports,

monitoring, and policies.

o Virtual Applications — Data pertaining to navigation, properties, topology, chargeback,

reports, and monitoring.

Obtaini

The Application Summary page is accessible by clicking the Application Viewer node in the tree.
It provides a snapshot of all the applications the management server detects.

ng a Summary of the Applications

e A pie chart with the number of:

Oracle Standalone Instances
Oracle RACs

SQL Server Standalone Instances
SQL Server Cluster Instances
Sybase Instances

Caché Instances

DB2 Instances

Informix Instances

Exchange Standalone Instances
Exchange Cluster Instances
Virtual Applications

Clustered Virtual Applications

o Atable to the right of the pie chart displaying the number of:

Oracle Standalone Instances
Oracle RACs

SQL Server Standalone Instances
SQL Server Cluster Instances
Sybase Instances

Caché Instances

DB2 Instances

Informix Instances

Exchange Standalone Instances

Exchange Cluster Instances

12



2 Accessing Information About Applications

= Virtual Applications
= Clustered Virtual Applications
= Total Applications

Navigation Information for Applications

The Navigation tab provides information about an element and how it relates to other elements in
its path. It is accessible by clicking the host name under the following nodes:

o Oracle:

Application Viewer (f"F) > Oracle

¢ Microsoft Exchange:

Application Viewer (f"F) > Microsoft Exchange

o Microsoft SQL Server:

Application Viewer (f"F) > SQLServer.
e Sybase:

Application Viewer (f"F) > Sybase.

o Caché:

Application Viewer (f"F) > Caché.

o DB2:

Application Viewer (f"F) > DB2

¢ Informix:

Application Viewer (f"F) > Informix.

To learn more about another element in the path, click the element on the Navigation tab. For an
explanation of the boxes for each element, see its corresponding online help. For example, if you
want to learn more about the storage volumes on the host, click the Storage Volumes box on this
page. A table appears with the storage volumes listed.

You can access additional functionality by clicking the following tabs at the top of the page.
o Properties — The Properties tab provides a detailed status of the element.

o Events — The Events tab displays the events pertaining to the element specified.

13



Chapter 2

Topology — The Topology tab provides a graphical representation of an element'’s path. It
displays additional information not found in System Manager, such as adapters, slots, and
Fibre Channel ports.

Chargeback — The Asset Management tab lets you keep track of asset attributes, such as
contact information for the element's owner.

Collectors — The Collectors tab lets you start a collector for a report and view the collector’s
corresponding reports once the information has been gathered.

Monitoring — The Monitoring tab lets you quickly access Performance Manager.
Performance Manager lets you quickly view information about an application.

Policies — The Policies tab lets you create utilization polices, which can send an email,
generate an event, or run a custom script when a set threshold for an element is triggered.

There are some situations in which the tabs may not all be visible:

The management server has discovered the application, but it cannot obtain additional
information about the application.

The application is a virtual application, which is a placeholder in the topology for applications
the management server cannot monitor.

The element was created when you created a record.

Events for Applications

The Events page view displays the following information about events associated with the
application and its dependent elements:

ID — The identifier assigned to the event.
Severity — The severity level of the event.
Time — The time the event was recorded.

Summary Text — A brief explanation of the event. To learn more about an event, click the link
for the summary text.

The following table provides an overview of the severity levels:

Table 1 Icons in Event Manager

Icon Description

i The event is marked cleared.
7) The severity of the event is not known.
I The event is informational.

14



2 Accessing Information About Applications

Icon Description

oy The event might have some impact.

The event has a minor impact.

The event has a major impact.

& The event has a critical impact.

To view more information about an event, click the link in its summary text. After you click the
link, the Event Details pane provides information on one or more of the following:

Serial Number — The number assigned to the event.
Summary Text — A brief explanation of the event.

Element — The source of the event. An element can be a switch, host, application, fabric, or
anything else on the network. If this box is blank, the event did not come from an element.

Source - If the event came from an element, the name of the element.
Time Reported — The time the event was reported to the management server.
Probable Cause — An explanation of a probable cause.
Recommended Actions — Recommendations.
Event Type — A description of the event.
Correlated Indications — Information obtained from the provider.
Severity — The severity level, which can be one of the following:

n Clear

= Unknown

= Informational

= Warning

= Minor

= Major

= Critical

Journal Entries — Use this box to enter additional information and then click Add Journal
Entry. This box is limited to 4,000 characters.

Note: Events listed in Event Manager may not be attributed to the correct source until
Getting Details has completed.
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Chapter 2

Accessing the Events Page

To access the Events page for an application, follow these steps:
1. Click the Events node in the Application Viewer tree.

2. Traverse the following path:

Application Viewer (PF) > [application_name] > Instance Name
In this instance, [application_name] is the name of the application; for example Oracle.

3. Click the Events node.

Viewing Performance Information

You can easily access performance information about an element, such as an application by
accessing Performance Manager. Performance Manager provides detailed graphs to help you

with monitoring your application. See the user guide or online help for more information about
Performance Manager.

About Chargeback for Applications

Chargeback helps you manage departmental ownership, track cost, and assemble business
reports, making inquiries, such as audits and inventory reviews, easier.

The management server provides the following types of chargeback.

o Asset-based — Asset-based chargeback calculates chargeback based on the departmental
ownership percentages and the depreciated value of the assets. Each piece of equipment is
owned by a department or a set of departments. Each department has a percentage
ownership of the equipment.

o Storage-based — Storage-based chargeback calculates charges based on the actual amount
of storage used by an application, the type of storage it is using, and the ownership
percentage assigned to each department. The chargeback number is further refined by an
additional fixed infrastructure tax on a per-department basis.

To learn more about Chargeback, see the user guide.
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3 Monitoring Microsoft Exchange

Depending on your license, monitoring Microsoft Exchange instances may not be available. See
the List of Features to determine if you have access to monitoring Microsoft Exchange instances.
The List of Features is accessible from the Documentation Center (Help > Documentation
Center).

This chapter contains the following topics:
¢ Monitoring Microsoft Exchange Overview below
e Managing Microsoft Exchange Domain Controller Access on next page
¢ Configuring User Mailbox and Public Folder Data Collection on page 20
o Viewing Properties for a Microsoft Exchange Instance on page 21
¢ Viewing Topology for Microsoft Exchange on page 27
o Viewing Exchange Reports on page 33

Monitoring Microsoft Exchange Overview

Before you can monitor Microsoft Exchange Server, you must do the following. For more
information, see the installation guide.

¢ Have the license for monitoring Microsoft Exchange. To determine if your license supports
the monitoring of Microsoft Exchange, see the List of Features.

¢ Add information for Microsoft Exchange Domain Controller Access
¢ Discover hosts running Microsoft Exchange Servers.
Key Benefits
o Accelerates time to deployment of Microsoft Exchange
o Improves Microsoft Exchange availability
¢ Assists Microsoft Exchange administrators in planning to avert potential disasters
e Maximizes the return on Microsoft Exchange assets
Key Features

o Ability to perform the end-to-end provisioning and configuration required to install Microsoft
Exchange

¢ Real-time monitoring of Microsoft Exchange storage
¢ Microsoft Exchange store-to-disk topology view

¢ Intelligent event management that correlates events across the system
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Chapter 3

Autodiscovery and management of all the storage infrastructure components required:
servers, HBAs, switches, and storage systems

Standards-based (CIM/WBEM/SMI) management platform
Web-based global management console

Ease of installation, deployment, and manageability

Managing Microsoft Exchange Domain Controller Access

Adding a Microsoft Exchange Domain Controller

Before adding a domain controller, note the following:

The hosts should recognize the management server by name, because a reverse look-up is
required by both operating system security and Microsoft Exchange. Make sure the domain
controller, Exchange server host, and management server are accessible to one another
using the host name and the fully-qualified domain name.

The user name you provide could be either the Windows logon name or Common Name (CN)
of the Active Directory User for accessing the Microsoft Exchange server.If the CN is
provided, make sure that the user resides under the default Users Organization Unit (UO). If
the Windows logon name is provided, it should be in the format: Domain\Username and the
corresponding user could be in any OU.

To find the CN for a user on a domain controller server, follow these steps:
1.
2.
3.

Install the ADSIEdit MMC snap-in if it is not installed.
Select Start > Run and enter adsiedit.msc.

When the snap-in opens, expand the DOMAIN directory and navigate to the CN=Users
folder to see the CN for each user in the Active Directory.

To provide information about your domain controllers, follow these steps:

1.

2.

3.

Select Discovery > Setup, and then click the Applications tab.
In the Exchange Information section, click Create.
Click the Add New Domain Controller link.

a. Inthe Domain box, enter the domain name.

b. Inthe Domain Controller Name box, enter the fully qualified DNS name for the domain
controller.

c. Inthe User Common Name box, enter the Windows logon name or the Common Name
(CN) of the Active Directory User for accessing the Microsoft Exchange server.

d. Inthe Domain Password box, enter the corresponding password for accessing the
Microsoft Exchange server.

e. Inthe Verify Password box, re-enter the password for verification.
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3 Monitoring Microsoft Exchange

Click Add.

The domain controller is added to the table.
Click OK.

Repeat these steps for each domain controller.

When all of your domain controllers are added, run wmiadap /£ onthe Exchange Serverto
refresh the Exchange data.

Editing a Microsoft Exchange Domain Controller

To provide information about your domain controllers, follow these steps:

1.
2
3.
4

5.

Select Discovery > Setup, and then click the Applications tab.

Click the Edit button next to the Exchange domain controller you want to edit.
Enter a new User Common Name or Domain Password.

Click Edit.

The domain controller updates are added to the table.

Click OK.

Deleting a Microsoft Exchange Domain Controller

To delete all of the domain controllers of a particular domain, follow these steps:

1.

2.
3.

Select Discovery > Setup, and then click the Applications tab.

Click the Delete (m) button corresponding to the domain you want to remove.

Run Get Details for your changes to take effect.

To delete a particular domain controller in a domain:

1.

2.

Select Discovery > Setup, and then click the Applications tab.

Identify the domain for the domain controller you want to remove, and click the Edit ( Qf)
button corresponding to that domain.

In the Edit window, click the Delete (ﬁ) button corresponding to the domain controller you
want to remove.

Run Get Details for your changes to take effect.
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Chapter 3

Configuring User Mailbox and Public Folder Data
Collection

The Application Viewer can be configured to collect information about Microsoft Exchange user
mailboxes and public folders. After you configure Application Viewer, HP Storage Essentials
uses the following to collect information from the Microsoft Exchange server:

e Windows Powershell. The product defaults to Windows Powershell for Microsoft Exchange
2007 servers.

¢ Windows Management Instrumentation (WMI). The product default to WMI for Microsoft
Exchange 2003 servers.

e Messaging Application Programming Interface (MAPI). The product defaults to MAPI for
Microsoft Exchange 2000 servers.

To enable the product to collect information from the Microsoft Exchange server, follow these
steps:

1. Onthe Exchange server host, change the logon account for the AppStorWin32Agent
service to a Domain Administrator account or Exchange View Only Administrator privileges
account that has a valid mailbox configured:

a. Navigate to Control Panel > Administrative Tools > Services.
b. Select the AppStorWin32Agent service.

c. Click the Properties button.

d. Select the Logon tab.

e. Change the “Logon as” account to a Domain Administrator or Exchange View Only
Admin user instead of a Local System account, and click OK.

f. Restart the AppStorWin32Agent service.

2. By default, mailbox collection is disabled on the management server. Schedule and start the
Mailbox Collectors on the Collectors tab for the Exchange Server instance. The default time
interval for the collector is one week. For instructions on using the Collector’s tab, see the
user guide.

Viewing Events for a Microsoft Exchange Instance

You can view events pertaining to a Microsoft Exchange instance and its dependent elements,
such as switches and storage systems, by following these steps:

1. Click Application Viewer (fh’}'T ).

2. Expand the node for the Microsoft Exchange instance from which you want to obtain event
information.
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3 Monitoring Microsoft Exchange

3. Click Path Events.

The events for that Microsoft Exchange instance and its dependent elements are displayed in the
right pane.

The management server provides the following information about the events:
¢ ID - The identification number assigned to the event.
o Severity — The severity level.
o Time —The time the event was recorded.
« Element - The affected host or application.

e« Summary Text — A brief explanation of the event. When you click the summary text, the
details of the event are displayed.

For more information, see “Managing Events” in the user guide.

Viewing Properties for a Microsoft Exchange Instance

Assigning a Custom Name

To make it easier to identify an element instance in the system, assign the instance a Custom
Name. The Custom Name also appears in Chargeback Manager.

Do not assign a custom name during “Get Topology” or Get Details. You can determine if the
management server is getting the topology or all element details by looking at the label near the
status button.

All users query the same database, so this name is displayed to others using the software. You
can make them aware of the name by following these steps:

1. Access the Custom Name box by doing one of the following:

¢ Double-click a Microsoft Exchange instance in System Manager, and then click the
Properties tab.

Or

o Click a Microsoft Exchange instance under the Microsoft Exchange node in Application
Viewer, and then click the Properties tab.

2. Inthe Custom Name box, enter a name:
= The name must contain 1 to 64 characters.

= The name must begin with a letter. Any character other than the first character can be a
letter, a numeral (0 to 9), or one of the following symbols: dollar sign ($), caret (*),
hyphen (-), underscore (_), or space.

= The name is case sensitive; for example, "Element1" and "element1" are different
elements.

3. Click Save.
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Chapter 3

Properties of an Exchange Server

To view detailed properties of the Exchange Server, follow these steps:

1. Access Application Viewer by clicking Application Viewer (+ l ).
2. Access the Properties tab by doing one of the following:

o Click the Microsoft Exchange instance under the Microsoft Exchange node in Application
Viewer.

Or
o Double-click the application icon for the Microsoft Exchange instance in System Manager.
3. Click the Properties tab.
The following properties are displayed:

= Custom Name — To make it easier to identify the element instance in the system,
assign the instance a Custom Name. The Custom Name also appears in Chargeback.
All users query the same database, so this name is displayed to others using the
software. Therefore, you might want to make them aware of the name. For more
information, see Assigning a Custom Name on previous page.

= Business Cost— The management server lets you assign a business cost to an
application, including virtual applications. This information is used in Event Manager for
ranking events from elements. Event Manager determines the rank of an event by
taking into account the business cost of the application and the severity of the event.
You can sort events by rank in Event Manager by clicking the Rank column. For more
information, see “Assigning a Business Cost to an Application” in the user guide.

= Type

n Cluster

= Build Number

= Version

= Active Node (if part of a cluster)
= Product Name

= Discovery Status

= Record Created

= Host/Host Cluster — To learn more about the host, click its link.
= Serial Number

= Identification Code

= Description
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3 Monitoring Microsoft Exchange

Participating Nodes (clusters only)
Target Operating System
Contacted

Vendor

Name Detected

Storage Groups — To obtain more information about an Exchange storage group, click
the storage group.

Application Clusters — To obtain more information about an application cluster, click
its link.

Update Element Data — To update the displayed properties, click the Update
Element Data button at the bottom of the screen. The management server gathers new
and changed details from the element and then redraws the topology with the updated
information.

Properties of an Exchange Storage Group

To view the properties of a storage group for a Microsoft Exchange instance, follow these steps:

1. Access Application Viewer by clicking Application Viewer (+ il )-

2. Access the Properties tab by doing one of the following:

¢ Click the Microsoft Exchange instance under the Microsoft Exchange node in Application
Viewer.

Or

o Double-click the application icon for the Microsoft Exchange instance in System Manager.

3. Click the Properties tab.

4. Inthe Storage Groups section, click the storage group you want to learn more about.

The following properties are displayed for the storage group:

Active Directory Name

Discovery Status

Record Created

Contacted

Description

MS Exchange Instance

MS Exchange Stores — To learn more about a store, click its link.

MS Transaction Logs — Click the link to view the log.

23



Chapter 3

Properties of an Exchange Store

To view the properties of a store for a Microsoft Exchange instance, follow these steps:

1. Access Application Viewer by clicking Application Viewer (f“'F ).
2. Access the Properties tab by doing one of the following:

o Click the Microsoft Exchange instance under the Microsoft Exchange node in Application
Viewer.

Or
o Double-click the application icon for the Microsoft Exchange instance in System Manager.
3. Click the Properties tab.
4. Inthe Storage Groups table, click the storage group you want to learn more about.
5. Inthe MS Exchange Stores section, click the mailbox store you want to learn more about.
The Mailbox Store Properties tab shows:
= Active Directory Name
= Discovery Status
= Record Created
= MS Exchange Storage Group
= Logical Disk
= Contacted
= File Path
= Data File Path
= MS Exchange Instance

For private stores, the list of user mailboxes is provided with hyperlinks.

Properties of a User Mailbox

To view the properties of a user mailbox on a Microsoft Exchange private store, follow these
steps:

=l

1. Access Application Viewer by clicking Application Viewer (+""™).
2. Access the Properties tab by doing one of the following:

o Click the Microsoft Exchange instance under the Microsoft Exchange node in Application
Viewer.

Or
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3 Monitoring Microsoft Exchange

o Double-click the application icon for the Microsoft Exchange instance in System Manager.
Click the Properties tab.
In the Storage Groups table, click the storage group you want to learn more about.

In the MS Exchange Stores section, click the mailbox store that holds the user mailbox.

o o >~ W

Click the individual mailbox link to view properties for the mailbox user.
The Mailbox Properties tab shows:

= Display Name

= Message Size

= Server name

= Storage Limit Information

= User Name (Last logged on user)

= Last Logon Time

= Legacy DN

= Mail Store

Properties of all User Mailboxes from an Exchange Instance

To view all user mailboxes from an Exchange Instance, follow these steps:

5

1. Access Application Viewer by clicking Application Viewer (+7"™).

2. Click the name of the Microsoft Exchange instance from which you want to obtain
information.

3. Click Mail Boxes tab.
The following properties are displayed for each mailbox:
= Mailbox Name
= Owner Name ( Last logged on user)
= Last Accessed
= Sizein MB
= Storage Limit Information
= Mail Store
= Storage Group
= Path

4. Optional: Filter the data on the Mail Boxes tab:
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a. Click Show Mailbox Filter.
b. Specify the filter criteria from the following:

o Mailboxes: All Mailboxes, Space Quota Not Exceeded, Space Quota
Exceeded: Warning Issued, Space Quota Exceeded: Send Prohibited, Space
Quota Status Not Checked.

o Not accessed in X days, weeks, or months.
o Mailbox Name
o Mailbox Size in MB
o Mailbox Store
o Storage Group
c. Click Filter.

Properties of a Public Folder

To view all the Public Folders from an Exchange Instance, follow these steps:

1. Click Application Viewer (*”F).

2. Click the name of the Microsoft Exchange instance from which you want to obtain
information.

3. Click the Public Folders tab.
The following properties are displayed for each public folder:
= Public Folder Name
= Last Accessed
= Sizein MB
4. Optional: Filter the data on the Public Folders tab:
a. Click Show Mailbox Public Folder Filter.
b. Specify the filter criteria from the following:
o Not accessed in X days, weeks, or months
o Public Folder Name
o Public Folder Size in MB
c. Click Filter.
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Viewing Topology for Microsoft Exchange
About the Topology Tab for Microsoft Exchange

The Topology tab provides a graphical representation of your storage network.

o Left pane — Provides a path view of the Microsoft Exchange database. When you select an
element in the left pane, its location is shown in the right pane.

¢ Right pane — Provides a logical diagram of the storage network. From the Topology tab, you
can determine the location of a device on the network. For example, to find out which storage
group contains the mailbox store, use the Topology tab.

From the Topology tab, you can obtain information about the host, storage volume, a Microsoft
Exchange storage group, or a Microsoft Exchange store by double-clicking its icon in the
topology.

You can also obtain information about a Microsoft Exchange LCR, and a Microsoft Exchange
CCR cluster. The Exchange CCR cluster replicates the database and transaction logs for each
storage group on an alterate path. This alternate path is called as the replication path.

You can view the replication paths for the Exchange cluster from the topology tab.

When you first access the Topology tab, you are told that the mount points have been filtered. In
the following figure, only the first storage group is displayed.

27



Chapter 3

Figure 1 Topology of Microsoft Exchange without Mount Points
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You can view the mount points in either of the following ways:

¢ Click the Filter (E) button in the upper-right comer of the screen. To view the Filter button,
you need to close the left pane. Select the mount points you want to view by clicking the
appropriate check boxes, as shown in the following figure.

Figure 2 Selecting Mount Points
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e You can also select the mount points from the Select menu.

28



3 Monitoring Microsoft Exchange

Figure 3 Selecting Mount Points from Combo Box
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When you are done selecting mount points, click Apply Filter. In the following figure, all of the

mount points were selected. Notice that all the storage groups are now displayed, as well as the
connecting switch and storage system.

Figure 4 Topology of Microsoft Exchange with Mount Points (1 of 2)
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Figure 5 Topology of Microsoft Exchange with Mount Points (2 of 2)
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Figure 6 Topology of Microsoft Exchange LCR Cluster
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Figure 7 Topology of Microsoft Exchange CCR Cluster
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In the figure, the dotted lines show the replication path of each database and storage groups
against the passive node.

Accessing the Topology Tab
Access the Topology tab by doing one of the following:

o Click a Microsoft Exchange instance under the Microsoft Exchange node in Application
Viewer, and then click the Topology button.

Or

o Double-click a Microsoft Exchange instance in System Manager, and then click the
Topology tab.

You can view property information for storage groups and stores by double-clicking theiricons in
the Topology tab.

Viewing Elements in the Microsoft Exchange Path

To view elements in the Microsoft Exchange path, follow these steps:
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1.
2.

Access Application Viewer by clicking Application Viewer (+ l ).

Click the Microsoft Exchange instance under the Microsoft Exchange node in Application
Viewer.

The Navigation tab displays the elements in the Microsoft Exchange path. You can learn more
about an element by clicking it. For example, to view information about dependent switches, click
the Switches button in the Navigation tab.

Viewing Exchange Reports

To view chargeback reports, follow these steps:

1.

2.
.

Click the Reporter button, and then expand the Reporter > System > Application nodes in
the tree in the middle pane.

Click one of the default Exchange reports:

Top N Exchange Mailboxes — Displays the largest mailboxes.

Top N Public Folders —Displays the largest public folders.

Top N Stale Mail boxes — Displays mailboxes with no activity in a set number of days.

Top N Stale Public Folders — Displays public folders with no activity in a set number of
days.

Select the number of results to display from the TopN menu.
Select one of the following options for a different output:
HTML

PDF

Excel

XML

To view the report in a new window, select the Open in new window option, and then click
Run Report.

For information on e-mailing reports, see “Sending a report by E-mail” in the user guide.
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Depending on your license, monitoring Oracle instances may not be available. See the List of
Features to determine if you have access to monitoring Oracle instances. The List of Features is
accessible from the Documentation Center (Help > Documentation Center).

This chapter contains the following topics:
e Monitoring Oracle Overview below
e Changing the Oracle TNS Listener Port on next page
¢ Enabling the Autoscan Feature on page 37
¢ Viewing Oracle ASM Information on page 37
¢ Viewing Events for an Oracle Instance on page 37
¢ Viewing Properties of an Oracle Instance on page 38

¢ Viewing Topology for Oracle on page 45

Monitoring Oracle Overview

Before you can monitor the Oracle Database, you must do the following. For more information,
see the installation guide.

o Have the license for monitoring Oracle. To determine if your license supports the monitoring
of Oracle, see the List of Features.

o Create the APPIQ_USER account for Oracle.
o If necessary, change the TNS Listener port.
o Discover the application.

The management software for Oracle is a CIM-based application storage management solution
that lets you realize the benefits of networked storage by more effectively managing your end-to-
end Oracle infrastructure from a single, easy-to-use console. By integrating real-time information
from storage devices, network components, servers, and operating systems with the application
database, the management software for Oracle can improve your Oracle database performance,
availability, and reliability and maximize your return on Oracle storage assets.

To help simplify the management of your Oracle storage, the management software for Oracle
provides comprehensive topology visualization from the Oracle tablespace to the mount point to
SAN switches to storage systems. This enables your storage and application administrators to
immediately visualize the interdependency of the infrastructure to the application. You will no
longer need to cross-reference multiple spreadsheets and call multiple people to get an end-to-end
picture.
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During periods of infrastructure downtime or other times of equipment failures, infrastructure
interdependencies are at your fingertips, so you can make the correct split-second decisions
when you are having issues with the infrastructure.

The management software for Oracle provides deep visibility into each component that makes up
the Oracle application, including Oracle configuration, host configuration, switch configuration,
and storage system configuration. This detailed information is provided at every level.

The management software for Oracle is built on CIM, Web-Based Enterprise Management
(WBEM), and the Storage Management Initiative (SMI) industry standards for heterogeneous
storage network management. The implementation of these standards allows the management
software for Oracle to support all your heterogeneous storage needs and ensures that your
investments in infrastructure can be leveraged in the future.

Key Benefits
o Improved Oracle database performance
¢ Increased Oracle database availability and reliability
e Maximized return on Oracle storage assets
Key Features
o Database-to-disk topology view
e Standards-based (CIM/WBEM/SMI-S) management platform
o Database-to-disk monitoring
¢ Real-time monitoring of Oracle storage
o Web-based global management console

o Ease of installation, deployment, and manageability

Changing the Oracle TNS Listener Port

The software uses port 1521 by default to communicate with the TNS Listener service on the
Oracle server. If your port is different or you use multiple ports, you can assign a new port number.

The hosts should recognize the management server by name, as a reverse look-up is required by
operating system security as well as the Oracle Transparent Network Substrate (TNS).

To change this port number or to add ports, follow these steps:
1. Select Discovery > Setup, and then click the Applications tab.
2. Toassign anew port, click the Create button for the Oracle Information table.

3. Enterthe new port number, and click OK.

If necessary, click the Delete (ﬂ) button to remove the old port number.

o &

Run discovery for the elements.
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Enabling the Autoscan Feature

Autoscan allows Oracle instances to be discovered automatically without having to enter the
application setup information. By default, discovery of Oracle through autoscan is disabled. To
enable autoscan, follow these steps:

1. Select Configuration > Product Health > Advanced.

2. Add the following line to the Custom Properties section:
oracleautoscan=true

3. Click Save.

4. Restart the AppStorManager service for your changes to take effect.

Auto scans are supported for both Oracle standalone instances and RACs. However Oracle
instances configured as failover cluster resources should always be discovered by explicitly
specifying the instance configuration. For details, see the Monitoring Oracle section of the
Discovering Applications, Backup Hosts and Hosts chapter of the user guide.

Autoscan is supported for Oracle 11g on HP-UX, AlX, Solaris, and Linux platforms.

If you are discovering an Oracle 11g instance, LISTENER.ORA should be located in one of the
following directories:

e <Oracle Home>/network/admin
e /etc
e /var/opt/oracle

If LISTENER.ORA is not located in one of these directories, use the TNS_LOC parameter in the
cim.extension.parameters file to specify where the file is stored.

Viewing Oracle ASM Information

The Oracle ASM diskgroups are displayed on the Host Navigation page when you click the
Volume Management button.

The Volume Management Software property for ASM diskgroups is set to Oracle Automatic
Storage Management and the Version of Software is set to the Oracle ASM software version.
Click the +Disks link to list the Disk Drives that form the ASM diskgroup.

Viewing Events for an Oracle Instance

To view events pertaining to an Oracle instance and its dependent elements, such as switches
and storage systems, follow these steps:

1. Access Application Viewer by clicking Application Viewer (f"F ).

2. Expand the node for the Oracle instance from which you want to obtain event information.
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3. Click Path Events.
The events for that Oracle instance and its dependent elements are displayed in the right pane.
The management server provides the following information about the events:

¢ ID - The identification number assigned to the event.

o Severity — The severity level.

o Time —The time the event was recorded.

o Summary Text— A brief explanation of the event. When you click the summary text, the
details of the event are displayed.

For more information, see “Managing Events” in the user guide.

Viewing Properties of an Oracle Instance

Assigning a Custom Name

To make it easier to identify an element instance in the system, assign the instance a Custom
Name. The Custom Name also appears in Chargeback Manager.

Do not assign a custom name during “Get Topology” or Get Details. You can determine if the
management server is getting the topology or all element details by looking at the label near the
status button.

All users query the same database, so this name is displayed to others using the software. You
can make them aware of the name by following these steps:

1. Access the Custom Name box by doing one of the following:
o Double-click an Oracle instance in System Manager, and then click the Properties tab.
Or

¢ Click an Oracle instance under the Oracle node in Application Viewer, and then click the
Properties tab.

2. Inthe Custom Name box, enter a name:
= The name must contain 1 to 64 characters.

= The name must begin with a letter. Any character other than the first character can be a
letter, a numeral (0 to 9), or one of the following symbols: dollar sign ($), caret (*),
hyphen (-), underscore (), or space.

= The name is case sensitive; for example, "Element1" and "element1" are different
elements.

3. Click Save.

Properties of an Oracle Instance

To view detailed properties of an Oracle instance, follow these steps:
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Access Application Viewer by clicking Application Viewer (+ l ).

Click the Oracle instance in Application Viewer.

Click the Properties tab.

The following properties are displayed:

Custom Name — To make it easier to identify the element instance in the system,
assign the instance a Custom Name. The Custom Name also appears in
Chargeback.For more information, see “Assigning a Custom Name” in the user guide.

Business Cost — The management server lets you assign a business cost to an
application, including virtual applications. This information is used in Event Manager for
ranking events from elements. Event Manager determines the rank of an event by
taking into account the business cost of the application and the severity of the event.
You can sort events by rank in Event Manager by clicking the Rank column. For more
information, see “Assigning a Business Cost to an Application” in the user guide.

Vendor

Contacted

Record Created
Discovery Status

Install Date

Name Detected

oID

Description

Target Operating System
Identification Code

Automatic Storage Management (ASM) — Displays a value of Yes or No based on
whether that particular database is using ASM for storage.

Product Name

Serial Number

Build Number

Version

Host — To learn more about the host, click its link.
Database Type

Databases — To learn more about a database, click its link.
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= Update Element Data — To update the displayed properties, click the Update
Element Data button at the bottom of the screen. The management server gathers new
and changed details from the element and then redraws the topology with the updated
information.

If this instance is an Oracle RAC instance, the following additional properties are displayed:

= Active Application Instances — A string representation of all of the active instances
that are part of this RAC. The format is:

<hostl-name>:<instancel-name>, <host2-name>:<instance2-name>...

= Number of instances — The number of configured instances on this RAC, including
inactive instances.

Properties of a Database Instance

To view detailed properties of a control group for an Oracle instance, follow these steps:

1. Access Application Viewer by clicking Application Viewer (+ il )-

Click the Oracle instance in Application Viewer.

Click the Properties tab.

ElE

Scroll to the bottom of the page, and click the database you want to learn more about.
The following properties are displayed for the database:

= Vendor

= Contacted

= Record Created

= Discovery Status

= Install Date

= Name Detected

= OID

= Description

= Type — The type of database.

= Database Logical Elements — To learn more about a database logical element, click
its link.

Properties of a Database Control File Group
To find the properties of a database control file for an Oracle instance, follow these steps:

1. Access Application Viewer by clicking Application Viewer (+ vl )-
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Click the Oracle instance in Application Viewer.
Click the Properties tab.

Scroll to the bottom of the page, and click the database containing the control group you want
to learn more about.

When you are shown the properties of the database, scroll to the bottom of the page to the
Database Logical Elements table, and click the database control file group you want to learn
more about.

The following properties for the database control file group are displayed:
= Vendor
= Contacted
= Record Created
= Discovery Status
= Install Date
= Name Detected
= OID
» Description
= Type — The type of file.

= Database Physical Elements — To learn more about a control file, click its link.

Properties of a Database Control File

To find the properties of a database control file for an Oracle instance, follow these steps:

A w0 DN

Access Application Viewer by clicking Application Viewer (+ l ).

Click the Oracle instance in Application Viewer.
Click the Properties tab.

Scroll to the bottom of the page, and click the database containing the control group you want
to learn more about.

When you are shown the properties of the database, scroll to the bottom of the page to the
Database Logical Elements table, and click the database control file group.

In the Database Physical Elements table, click the database control file you want to learn
more about.

The following properties for the database control file are displayed:
= Vendor

= Contacted
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= Record Created
= Discovery Status
= Install Date

= Name Detected
= OID

s Description

= File Path

= Status

= Data File Path

= Type

= Oracle Database Control File Group — Displays the control file group containing the
database control file. Click the control file group to learn more about it.

Properties of a Database Redo Group

To find the properties of a database redo group for an Oracle instance, follow these steps:

A 0D

5

Access Application Viewer by clicking Application Viewer (+7"™).
Click the Oracle instance in Application Viewer.
Click the Properties tab.

Scroll to the bottom of the page, and click the database containing the control group you want
to learn more about.

When you are shown the properties of the database, scroll to the bottom of the page to the
Database Logical Elements table, and click the database redo group you want to learn more
about.

The following properties for the database redo group are displayed:
= Vendor
= Contacted
= Record Created
= Discovery Status
= Install Date
= Name Detected
= OID

= Description
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» Type — The type of file.
= Database Physical Elements — To learn more about a database redo file, click its link.

Properties of a Database Redo File

To find the properties of a database redo file for an Oracle instance, follow these steps:

1. Access Application Viewer by clicking Application Viewer (+ ol )-
Click the Oracle instance in Application Viewer.

Click the Properties tab.

El

Scroll to the bottom of the page, and click the database containing the control group you want
to learn more about.

5. When you are shown the properties of the database, scroll to the bottom of the page to the
Database Logical Elements table, and click the database redo group containing the database
redo file.

6. Inthe Database Physical Elements table, click the database redo file you want to learn more
about.

The following properties for the redo file are displayed:
= Vendor
= Contacted
= Record Created
= Discovery Status
= Install Date
= Name Detected
= OID
= Description
= File Path
= Status
= Data File Path
= Type

= Oracle Database Redo Group — To learn more about the database redo group
containing the database redo file, click its link.

Properties of a Tablespace

To view detailed properties of a tablespace, follow these steps:
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A w0 DN

Access Application Viewer by clicking Application Viewer (+ l ).
Click the Oracle instance in Application Viewer.
Click the Properties tab.

Scroll to the bottom of the page, and click the database containing the control group you want
to learn more about.

When you are shown the properties of the database, scroll to the bottom of the page to the
Database Logical Elements table, and click the database tablespace you want to learn more
about.

The following properties for the database tablespace are displayed:
= Vendor
= Contacted
= Record Created
= Discovery Status
= Install Date
= Name Detected
= OID
= Description
= Type — The type of file.

= Database Physical Elements — To learn more about a tablespace file, click its link.

Properties of a Tablespace File

To view detailed properties of a tablespace file, follow these steps:

A 0D

Access Application Viewer by clicking Application Viewer (# il )-
Click the Oracle instance in Application Viewer.

Click the Properties tab.

Scroll to the bottom of the page, and click the database containing the control group you want
to learn more about.

When you are shown the properties of the database, scroll to the bottom of the page to the
Database Logical Elements table, and click the database tablespace you want to learn more
about.

In the Database Physical Elements table, click a tablespace file.
The following properties are displayed for the tablespace file:

= Vendor
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= Contacted

= Record Created
= Discovery Status
= Install Date

= Name Detected
= OID

= Description

= File Path

= Status

= Data File Path
= Type

= Oracle Database Tablespace — To learn more about the database tablespace
containing the database tablespace file, click its link.

Viewing Topology for Oracle
About the Topology Tab

The Topology tab provides a graphical representation of your storage network.

¢ Left pane — Provides a path view of the Oracle database. When you select an element in the
left pane, its location is shown in the right pane.

¢ Right pane — Provides alogical diagram of the storage network. From the Topology tab, you
can determine the location of a device on the network. For example, you could use the
Topology tab to find which tablespace uses a given data file.

From the Topology tab, you can obtain information about the host, Oracle instance, database
instance, control files, and redo files by double-clicking the appropriate icon in the topology.

When you first access the Topology tab, you are told that the mount points have been filtered.
Note that in the following figure, only one database file is displayed.
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Figure 8 Topology of Oracle Database without Mount Points
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You can view the mount points in either of the following ways.

¢ Click the Filter (E) button in the upper-right corner of the screen. To view the Filter button,
you need to close the left pane. Select the mount points you want to view by clicking the
appropriate check boxes, as shown in the following figure.
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Figure 9 Selecting Mount Point
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Figure 10 Selecting Mount Points from Combo Box
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When you are done selecting mount points, click Apply Filter. In the following figure, all of the
mount points were selected. Notice that all database control files are now displayed.
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Figure 11 Topology for an Oracle Instance with Mount Points
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Note: The topology was arranged so that as many components as possible could be
displayed in the figure; however, not all components could fit in the figure.

You can obtain property information about each component by double-clicking it.

Topology for Oracle RAC

The following figure provides an example of the topology for Oracle RAC.
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Figure 12 Topology for Oracle RAC
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Topology for Oracle RAC Showing an ASM Diskgroup as a Volume

Oracle ASM disk groups are represented as Volume Manager volumes. The following figure
shows an example of the topology for Oracle RAC showing an ASM diskgroup as a volume.
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Figure 13 Topology for Oracle RAC Showing ASM Diskgroup(DATA1) as a Volume
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Accessing the Topology Tab
Access the Topology tab by doing one of the following:

¢ Click an Oracle instance under the Oracle node in Application Viewer, and then click the
Topology tab.

Or
o Double-click an Oracle instance in System Manager, and then click the Topology tab.

You can view property information for the item displayed in the topology by double-clicking its
icon.

For more information see "About the Topology Tab" in the user guide.
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Viewing Elements in the Oracle Instance's Path

To view elements in the Oracle instance’s path, follow these steps:

1. Access Application Viewer by clicking Application Viewer (+ l ).
Click the Oracle instance in Application Viewer.

Click the Navigation tab.

A

Do one or more of the following:
= Tolearn more about the host, click Hosts.
= Tolearn more about the switches connected to the host, click Switches.

= Tolearn more about the storage systems associated with the host, click Storage
Systems.
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Depending on your license, monitoring Sybase instances may not be available. See the List of
Features to determine if you have access to monitoring Sybase instances. The List of Features is
accessible from the Documentation Center (Help > Documentation Center).

This chapter contains the following topics:
e Monitoring Sybase Overview below
e Viewing Events for Sybase on next page
¢ Viewing Properties for Sybase on page 55
¢ Viewing Topology for Sybase on page 57

Monitoring Sybase Overview

Before you can monitor Sybase Adaptive Server Enterprise, you must do the following:

o Have the license for monitoring Sybase Adaptive Server Enterprise. To determine if your
license supports the monitoring of Sybase, see the List of Features.

o Create APPIQ_USER account on the database to be managed.
e Provide the database server name and port number.
o Discover the application.

For more information, see the installation guide.

The management software for Sybase is a CIM-based application storage management solution
that lets you realize the benefits of storage in a network by more effectively managing your end-to-
end Sybase infrastructure from a single, easy-to-use console. By integrating real time information
from storage devices, network components, servers, and operating systems with the application
database, the management software for Sybase can improve your application's performance,
availability, and reliability and maximize your return on the applications storage assets.

To help simplify the management of your Sybase storage, the management software for Sybase
provides comprehensive topology visualization from the Sybase database files to the mount point
to SAN switches to storage systems. This enables your storage and application administrators to
immediately visualize the interdependency of the infrastructure to the application. You will no
longer need to cross-reference multiple spreadsheets and call multiple people to get an end-to-end
picture.

During periods of infrastructure downtime or other times of equipment failures, infrastructure
interdependencies are at your fingertips, so you can make the correct split-second decisions
when you are having issues with the infrastructure.
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The management software for Sybase provides deep visibility into each component that makes
up the Sybase application, including Sybase configuration, host configuration, switch
configuration, and storage system configuration. This detailed information is provided at every
level.

The management software for Sybase is built on CIM, Web-Based Enterprise Management
(WBEM), and the Storage Management Initiative (SMI) industry standards for heterogeneous
storage network management. The implementation of these standards allows the management
software for Sybase to support all your heterogeneous storage needs and ensures that your
investments in infrastructure can be leveraged in the future.

Key Benefits
¢ Improved Sybase database performance
¢ Increased Sybase database availability and reliability
e Maximized return on Sybase storage assets
Key Features
o Database-to-disk topology view
o Standards-based (CIM/WBEM/SMI-S) management platform
o Database-to-disk monitoring
¢ Real-time monitoring of Sybase storage
o Web-based global management console

o Ease of installation, deployment, and manageability

Viewing Events for Sybase

To view events pertaining to a Sybase database and its dependent elements, such as storage
systems. follow these steps:

1. Access Application Viewer by clicking Application Viewer (+ ol )-

2. Expand the node for the Sybase database from which you want to obtain event information.
3. Click Path Events.
The events for that Sybase database and its dependent elements are displayed in the right pane.
The management server provides the following information about the events:

¢ ID — The identification number assigned to the event.

o Severity — The severity level.

¢ Time - The time the event was recorded.
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o Summary Text— A brief explanation of the event. When you click the summary text, the

details of the event are displayed.

For more information, see “Managing Events” in the user guide.

Viewing Properties for Sybase

Properties of a Sybase Instance

To view the properties of a Sybase instance on a host, follow these steps:

1. Access Application Viewer by clicking Application Viewer (+

2. Click the Sybase instance in Application Viewer.

3. Click the Properties tab.

The following properties are displayed:

Custom Name — To make it easier to identify the element instance in the system,
assign the instance a Custom Name. The Custom Name also appears in Chargeback.
Since all users query the same database, this name is displayed to others using the
software. As a result, you might want to make them aware of the name.

Business Cost — The management server lets you assign a business cost to an
application, including virtual applications. This information is used in Event Manager for
ranking events from elements. Event Manager determines the rank of an event by
taking into account the business cost of the application and the severity of the event.
You can sort events by rank in Event Manager by clicking the Rank column.

Vendor

Contacted

Record Created
Discovery Status
Install Date

Name Detected
oID

Description

Target Operating System
Identification Code
Product Name
Serial Number

Build Number
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= Version

= Host—To learn more about the host, click its link.

= Database Type

= Databases — To learn more about a database, click its link in the Databases table.

= Update Element Data — To update the displayed properties, click the Update
Element Data button at the bottom of the screen. The management server gathers new
and changed details from the element and then redraws the topology with the updated
information.

Properties of a Sybase Database

To view the properties of a Sybase database, follow these steps:

=5

1. Access Application Viewer by clicking Application Viewer (+7*™).
Click the Sybase instance in Application Viewer.

Click the Properties tab.

A 0D

In the Databases table, click a database you want to learn more about.
The following properties are displayed:

= Vendor

= Contacted

= Record Created

= Discovery Status

= Install Date

= Sybase Instance

= Name Detected

= OID

= Description

= Type

= Database Logical Elements — To learn more about a Sybase database file, click its
link.

Properties of a Sybase Database File

To view the properties of a Sybase database file, follow these steps:

1. Access Application Viewer by clicking Application Viewer (+ il )-

2. Click the Sybase instance in Application Viewer.
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3. Click the Properties tab.
4. Inthe Databases table, click a database.
5. Inthe Database Logical Elements table, click the database file you want to learn more about.
The following properties are displayed:

= Vendor

= Contacted

= Record Created

= Discovery Status

= Install Date

= Name Detected

= OID

= DB Logical

= File Path

= Status

= Data File Path

= Type

Viewing Topology for Sybase
About the Topology Tab

The Topology tab provides a graphical representation of your storage network:

o Left pane — Provides a path view of the Sybase database. When you select an element in the
left pane, its location is shown in the right pane.

¢ Right pane — Provides a logical diagram of the storage network. From the Topology tab, you
can determine the location of a device on the network. For example, you could use the
Topology tab to find which database file corresponds to a database.

From the Topology tab, you can obtain information about an item in the topology by double-
clicking its icon.

When you first access the Topology tab, you are told that the mount points have been filtered.
Note that in the following figure, only one logical drive is displayed. One of the database
instances, sybsystemprocs, is shown disconnected, because its logical drive is not displayed.
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Figure 14 Topology of Sybase Database without Mount Points
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You can view the mount points in either of the following ways:

¢ Click the Filter (E) button in the upper-right corner of the screen. To view the Filter button,
you need to close the left pane. Select the mount points you want to view by clicking the
appropriate check boxes, as shown in the following figure.

Figure 15 Selecting Mount Points
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¢ You can also select the mount points from the Select menu.
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Figure 16 Selecting Mount Points from Combo Box
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e When you are done selecting mount points, click Apply Filter. In the following figure, all of
the mount points were selected. Notice that all database control files are now displayed, and
the database instance sybsystemprocs is shown connected to its logical drive.

Figure 17 Topology of Sybase Database with Mount Points
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You can obtain property information about each component by double-clicking it.

Accessing the Topology Tab
Access the Topology tab by doing one of the following:

¢ Clicking a Sybase instance under the Sybase node in Application Viewer, and clicking the
Topology button.

Or
¢ Double-clicking a Sybase instance in System Manager, and then clicking the Topology tab.

You can view property information for storage groups and stores by double-clicking their icons in
the Topology tab.
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Depending on your license, monitoring Microsoft SQL Server instances may not be available. See
the List of Features to determine if you have access to monitoring Microsoft SQL Server
instances. The List of Features is accessible from the Documentation Center (Help >
Documentation Center).

This chapter contains the following topics:
¢ Monitoring Microsoft SQL Server Overview below
o Viewing Events for SQL Server on next page
o Viewing Properties of a SQL Server on next page

¢ Viewing Topology for a SQL Server on page 64

Monitoring Microsoft SQL Server Overview

Before you can monitor Microsoft SQL Server you must do the following. see the installation guide
for more information.

¢ Have the license for monitoring Microsoft SQL Server. To determine if your license supports
the monitoring of Microsoft SQL Server, see the List of Features.

¢ Provide the database server name and port number.
o Discover the application.
Key Benefits
o Improved Microsoft SQL Server database performance
¢ Increased Microsoft SQL Server availability and reliability
e Maximized return on Microsoft SQL Server storage assets
Key Features
o Database-to-disk topology view
e Standards-based (CIM/WBEM/SMI-S) management platform
o Database-to-disk monitoring
¢ Real time monitoring of Microsoft SQL Server storage
o Web-based global management console

o Ease of installation, deployment, and manageability
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Viewing Events for SQL Server

To view events pertaining to a SQL Server database and its dependent elements, such as storage
systems, follow these steps:
1. Access Application Viewer by clicking Application Viewer (+""™).

2. Expand the node for the SQL Server database from which you want to obtain event
information.

3. Click Path Events.

The events for that SQL Server database and its dependent elements are displayed in the right
pane.

The management server provides the following information about the events:
¢ ID — The identification number assigned to the event.
o Severity — The severity level.
o Time —The time the event was recorded.

e« Summary Text — A brief explanation of the event. When you click the summary text, the
details of the event are displayed.

For more information, see “Managing Events” in the user guide.

Viewing Properties of a SQL Server

Properties of a SQL Server Instance

To view the properties of a SQL Server instance on a host, follow these steps:

1. Access Application Viewer by clicking Application Viewer (*’HF )-

2. Click the SQL Serverinstance in Application Viewer.
3. Click the Properties tab.
The following properties are displayed:

= Custom Name — To make it easier to identify the element instance in the system,
assign the instance a Custom Name. The Custom Name also appears in Chargeback.
Since all users query the same database, this name is displayed to others using the
software. As aresult, you might want to make them aware of the name. For more
information, see “Assigning a Custom Name” in the user guide.
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6 Monitoring Microsoft SQL Server

Business Cost — The management server lets you assign a business cost to an
application, including virtual applications. This information is used in Event Manager for
ranking events from elements. Event Manager determines the rank of an event by
taking into account the business cost of the application and the severity of the event.
You can sort events by rank in Event Manager by clicking the Rank column. For more
information, see “Assigning a Business Cost to an Application” in the user guide.

Vendor

Contacted

Record Created

Discovery Status

Install Date

Name Detected

oD

Description

Target Operating System

Identification Code

Product Name

Serial Number

Build Number

Version

Host — To learn more about the host, click its link.
Database Type

Databases — To learn more about a database, click its link in the Databases table.

Update Element Data — To update the displayed properties, click the Update
Element Data button at the bottom of the screen. The management server gathers new
and changed details from the element and then redraws the topology with the updated
information.

Properties of a SQL Server Database

To view the properties of a SQL Server database, follow these steps:
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Access Application Viewer by clicking Application Viewer (+"™).
Click the Microsoft SQL Server instance in Application Viewer.
Click the Properties tab.

In the Databases table, click the database you want to learn more about.
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The following properties are displayed:
= Name Detected
= Install Date
= Vendor
= Discovery Status
= Record Created
= Contacted
= OID
= Description
= Type

= SQLServer Instance — To learn more about the instance, click its link.

Properties of a SQL Server Database File
To view the properties of a SQL Server database file, follow these steps:
1. Access System Manager.
2. Double-click the SQL Servericon in System Manager.
3. Click the Topology tab.
4. Double-click the database file in the topology displayed.

Viewing Topology for a SQL Server
About the Topology Tab

The Topology tab provides a graphical representation of your storage network.

o Left pane — Provides a path view of the SQL Server database. When you select an element
in the left pane, its location is shown in the right pane.

¢ Right pane — Provides a logical diagram of the storage network. From the Topology tab, you
can determine the location of a device on the network. For example, you could use the
Topology tab to find which database file corresponds to a database.

From the Topology tab, you can obtain information about an item in the topology by double-
clicking its icon.

When you first access the Topology tab, you are told that the mount points have been filtered.
Note that in the following figure, only one logical drive is displayed.
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Figure 18 SQL Server without Mount Points
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You can view the mount points in either of the following ways:

¢ Click the Filter (E) button in the upper-right corner of the screen. To view the Filter button,
you need to close the left pane. Select the mount points you want to view by clicking the
appropriate check boxes, as shown in the following figure.

Figure 19 Selecting Mount Points
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e You can also select the mount points from the Select menu. You can only select one mount
point at a time when you select a mount point from the Select menu. For example, assume
you have mount points C and F selected. If you select a mount point from the Select menu,
only one mount point is selected.

Figure 20 Selecting a Mount Point from the Select Menu
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When you are done selecting mount points, click Apply Filter. In the following figure, mount
points C and F were selected, but not D. Since the Northwind database is connected to the D

mount point, it is not shown as connected.

Select | Mo MountPoint
[ D Mo MaountPoint
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Figure 21 Topology of SQL Server Database with Two Mount Points
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You can obtain property information about each component by double-clicking it.

Accessing the Topology Tab
Access the Topology tab by doing one of the following:

¢ Click a SQL Server instance under the SQLSERVER node in Application Viewer, and click
the Topology button.

Or
o Double-click a SQL Server instance in System Manager, and then click the Topology tab.

You can view property information for storage groups and stores by double-clicking theiricons in
the Topology tab.
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Depending on your license, the monitoring of Caché instances may not be available. See the List
of Features to determine if you have access to monitoring Caché. The List of Features is
accessible from the Documentation Center (Help > Documentation Center).

This chapter contains the following topics:
e Monitoring Caché Overview below
e Viewing Events for a Caché Instance on next page
¢ Viewing Properties of a Caché Instance on next page

e Viewing Topology for Caché on page 75

Monitoring Caché Overview

Before you can monitor Caché, you must do the following. For more information, see the
installation guide.

o Have the license for monitoring Caché. To determine if your license supports the monitoring
of Caché, see the List of Features.

o Import the wrapper class definitions into the Caché instance.
o Create APPIQ_USER account on the Caché instance.
e Provide the database server name and port number.
o Discover the application.
Key Benefits
¢ Improved Caché database performance
¢ Increased Caché database availability and reliability
e Maximized return on Caché storage assets
Key Features
o Database-to-disk topology view
o Standards-based (CIM/WBEM/SMI-S) management platform
o Database-to-disk monitoring
¢ Real-time monitoring of Caché storage
o Web-based global management console

o Ease of installation, deployment, and manageability
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Viewing Events for a Caché Instance

To view events pertaining to a Caché instance and its dependent elements, such as switches and
storage systems, follow these steps:
1. Access Application Viewer by clicking Application Viewer (/h‘JIF )-
2. Expand the node for the Caché instance from which you want to obtain event information.
3. Click Path Events.
The events for that Caché instance and its dependent elements are displayed in the right pane.
The management server provides the following information about the events:
¢ ID - The identification number assigned to the event.
e Severity — The severity level.
e Time —The time the event was recorded.

o Summary Text— A brief explanation of the event. When you click the summary text, the
details of the event are displayed.

For more information, see “Managing Events” in the user guide.

Viewing Properties of a Caché Instance

Properties of a Caché Application

To view the properties of a Caché instance, follow these steps:

1. Access Application Viewer by clicking Application Viewer (/"'F ).
2. Click the Caché instance in Application Viewer.
3. Click the Properties tab.

The following properties are displayed:

= Custom Name — To make it easier to identify the element instance in the system,
assign the instance a Custom Name. The Custom Name also appears in Chargeback.
For more information, see “Assigning a Custom Name” in the user guide.

= Business Cost— The management server lets you assign a business cost to an
application, including virtual applications. This information is used in Event Manager for
ranking events from elements. Event Manager determines the rank of an event by
taking into account the business cost of the application and the severity of the event.
You can sort events by rank in Event Manager by clicking the Rank column. For more
information, see “Assigning a Business Cost to an Application” in the user guide.

= Name Detected
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Vendor

Discovery Status

Record Created

Contacted

Description

Product Name

Identification Code

Target Operating System

Host — To learn more about the host, click its link.

Serial Number

Build Number

Version

Type

Port

Cluster — Whether the application is part of an application cluster.
Databases — To learn more about a database, click its link.

Application Clusters

To update the displayed properties, click the Update Element Data button at the bottom of the
screen. The management server gathers new and changed details from the element and then
redraws the topology with the updated information.

Properties of a Caché Instance

To view the properties of a Caché instance, follow these steps:
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Access Application Viewer by clicking Application Viewer ("),

Click the Caché instance in Application Viewer.

Click the Properties tab.

In the Databases table, click a Caché instance that you want to learn more about.

The following properties are displayed:

Discovery Status
Record Created
Contacted

Description
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= Type
= Database — To learn more about the application, click its link.

= Database Logical Elements — Databases and Journals are listed under the database
logical elements. To learn more about a database logical element, click its link.
Note:Unmounted databases are not listed here.

= Virtual Elements — Namespaces are listed under the database virtual elements. To
learn more about a database virtual element, click its link.

Properties of a Caché Namespace

To find the properties of a namespace for a Caché instance, follow these steps:

1. Access Application Viewer by clicking Application Viewer (+ il ).

2. Click the Caché instance in Application Viewer.

3. Click the Properties tab.

4. Scroll to the bottom of the page, and click the Caché instance.

5. When you are shown the properties of the Caché instance, scroll to the bottom of the page to

the Database Virtual Elements table, and click the namespace that you want to learn more
about.

The following properties for the namespace are displayed:
= Discovery Status
= Record Created
= Contacted
= Description
= Database — To learn more about the application, click its link.
= Instance Element — To learn more about the instance, click its link.

= Database Logical Elements — All the databases associated with the namespace are
listed under this table. To learn more about a database, click its link.

Properties of a Caché Database

To find the properties of a database for a Caché instance, follow these steps:

1. Access Application Viewer by clicking Application Viewer (+ ol ).
Click the Caché instance in Application Viewer.

Click the Properties tab.

A 0D

Scroll to the bottom of the page, and click the Caché instance.
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5. When you are shown the properties of the Caché instance, scroll to the bottom of the page to
the Database Logical Elements table, and click the database that you want to learn more
about.

The following properties for the database are displayed:

Discovery Status

Record Created

Contacted

Description

Type

Expansion Size

Resource

Last Expansion Time

Reason

Database — To learn more about the application, click its link.

Database Physical Elements — All the files constituting this database are listed under
this table. To learn more about a database file, click its link.

You can also access Database properties by clicking on the database listed under Database
Logical Elements in the Namespace properties page.

Properties of a Caché Database File

To find the properties of a database for a Caché instance, follow these steps:
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Access Application Viewer by clicking Application Viewer (+"").

Click the Caché instance in Application Viewer.

Click the Properties tab.

Scroll to the bottom of the page, and click the Caché instance.

When you are shown the properties of the Caché instance, scroll to the bottom of the page to
the Database Logical Elements table, and click the database that you want to learn more
about.

In the Database Physical Elements table, click a database file.

The following properties for the database file are displayed:

Discovery Status
Record Created

Contacted
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Description
File Path
Status

Data File Path
Type

Database Logical Element — To learn more about the database containing the
database file, click its link.

Logical Disk — To learn more about the logical disk on which the file is located, click its
link.

Database — To learn more about the application, click its link.

Properties of a Caché Journal

To find the properties of a journal for a Caché instance, follow these steps:

o > @D

Access Application Viewer by clicking Application Viewer (+ ol ).

Click the Caché instance in Application Viewer.

Click the Properties tab.

Scroll to the bottom of the page, and click the Caché instance.

When you are shown the properties of the Caché instance, scroll to the bottom of the page to
the Database Logical Elements table, and click the journal that you want to learn more about.

The following properties for the journal are displayed:

Discovery Status

Record Created

Contacted

Description

Type

Expansion Size

Resource

Last Expansion Time

Reason

Database — To learn more about the application, click its link.

Database Physical Elements — To learn more about a journal, click its link.
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Properties of a Caché Journal File

To find the properties of a journal file for a Caché instance, follow these steps:

1. Access Application Viewer by clicking Application Viewer (f“'F ).

o > w0 DN

Click the Caché instance in Application Viewer.
Click the Properties tab.
Scroll to the bottom of the page, and click the Caché instance.

When you are shown the properties of the Caché instance, scroll to the bottom of the page to

the Database Logical Elements table, and click the journal that you want to learn more about.

6. Inthe Database Physical Elements table, click a journal file.

The following properties for the journal file are displayed:

Discovery Status
Record Created
Contacted
Description

File Path

Status

Data File Path
Type

Database Logical Element — To learn more about the journal containing the journal
file, click its link.

Logical Disk — To learn more about the logical disk on which this file is located, click
its link.

Database — To learn more about the application, click its link.

Viewing Topology for Caché

About the Topology Tab

The Topology tab provides a graphical representation of your storage network.

o Left pane — Provides a path view of the Caché application. When you select an element in
the left pane, its location is shown in the right pane.
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¢ Right pane — Provides a logical diagram of the storage network. From the Topology tab, you
can determine the location of a device on the network. For example, you could use the
Topology tab to find which tablespace uses a given data file.

From the Topology tab, you can obtain information about the host, Caché application, Caché
instance, database files, and journal files by double-clicking the appropriate icon in the topology.

When you first access the Topology tab, you are told that the mount points have been filtered.
Note that in the following figure, only one mount point is displayed.

Figure 22 Topology of Caché Instance with a Single Mount Point
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To view mount points, click the Filter (E) button in the upper-right corner of the screen. To view
the Filter button, you need to close the left pane. Select the mount points you want to view by
clicking the appropriate check boxes, as shown in the following figure:
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Figure 23 Selecting Mount Points
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You can also select the mount points from the Select menu.

Figure 24 Selecting Mount Points from the Menu
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When you are done selecting mount points, click Apply Filter. In the following figure, all of the

mount points were selected. Notice that all database files are now displayed.
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Figure 25 Topology for a Caché Instance with Mount Points
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In the figure, the topology was arranged so that as many components as possible could be
displayed; however, not all components could fit.

You can obtain property information by double-clicking a component.

Accessing the Topology Tab
Access the Topology tab by doing one of the following:

e Click a Caché instance under the Caché node in Application Viewer, and then click the
Topology tab.

Or
e Double-click a Caché instance in System Manager, and then click the Topology tab.

You can view property information for the item displayed in the topology by double-clicking its
icon.

For more information, see “About the Topology Tab” in the user guide.

Viewing Elements in the Caché Instance's Path

To view elements in the Caché instance’s path, follow these steps:
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A w0 DN

Access Application Viewer by clicking Application Viewer (+ l ).
Click the Caché instance in Application Viewer.
Click the Navigation tab.
Do one or more of the following:
= Tolearn more about the host, click Hosts.
= Tolearn more about the switches connected to the host, click Switches.

= Tolearn more about the storage systems associated with the host, click Storage
Systems.
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Depending on your license, the monitoring of Informix instances may not be available. See the
List of Features to determine if you have access to monitoring Informix. The List of Features is
accessible from the Documentation Center (Help > Documentation Center).

This chapter contains the following topics:
e Monitoring Informix Overview below
¢ Viewing Events for an Informix Instance on next page
¢ Viewing Properties of an Informix Instance on page 83

o Viewing Topology for Informix on page 86

Monitoring Informix Overview

Before you can monitor Informix Dynamic Server, you must do the following:

¢ Have the license for monitoring Informix Dynamic Server. To determine if your license
supports the monitoring of Informix Dynamic Server, see the List of Features.

o Create a Managed Database User in HP Storage Essentials.
e Provide the database server name and port number.
o Discover the application.

For more information, see the installation guide.

The management software for Informix is a CIM-based application storage management solution
that lets you realize the benefits of storage in a network by more effectively managing your end-to-
end Informix infrastructure from a single, easy-to-use console. By integrating real time information
from storage devices, network components, servers, and operating systems with the application
database, the management software for Informix can improve your application's performance,
availability, and reliability and maximize your return on the application’s storage assets. To help
simplify the management of your Informix storage, the management software for Informix
provides comprehensive topology visualization from the Informix database files to the mount point
to SAN switches to storage systems. This enables your storage and application administrators to
immediately visualize the interdependency of the infrastructure to the application. You will no
longer need to cross-reference multiple spreadsheets and call multiple people to get an end-to-end
picture. During periods of infrastructure downtime or other times of equipment failures,
infrastructure interdependencies are at your fingertips, so you can make the correct split-second
decisions when you are having issues with the infrastructure.

The management software for Informix provides deep visibility into each component that makes
up the Informix application, including Informix configuration, host configuration, switch
configuration, and storage system configuration. This detailed information is provided at every
level.
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The management software for Informix is built on CIM, Web-Based Enterprise Management
(WBEM), and the Storage Management Initiative (SMI) industry standards for heterogeneous
storage network management. The implementation of these standards allows the management
software for Informix to support all your heterogeneous storage needs and ensures that your
investments in infrastructure can be leveraged in the future.

Key Benefits
o Improved Informix database performance
¢ Increased Informix database availability and reliability
e Maximized return on Informix storage assets
Key Features
o Database-to-disk topology view
o Standards-based (CIM/WBEM/SMI-S) management platform
o Database-to-disk monitoring
¢ Real-time monitoring of Informix storage
¢ Web-based global management console

o Ease of installation, deployment, and manageability

Viewing Events for an Informix Instance

To view events pertaining to an Informix instance and its dependent elements, such as switches
and storage systems, follow these steps:
1. Access Application Viewer by clicking Application Viewer (+ l ).
2. Expand the node for the Informix instance from which you want to obtain event information.
3. Click Path Events.
The events for that Informix instance and its dependent elements are displayed in the right pane.
The management server provides the following information about the events:

¢ ID - The identification number assigned to the event.

o Severity — The severity level.

o Time —The time the event was recorded.

o Summary Text— A brief explanation of the event. When you click the summary text, the
details of the event are displayed.

For more information, see “Managing Events” in the user guide.
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Viewing Properties of an Informix Instance

Properties of an Informix Instance

To view the properties of an Informix instance, follow these steps:

1. Access Application Viewer by clicking Application Viewer (+ ol )-

2. Click the Informix instance in Application Viewer.

3. Click the Properties tab.

The following properties are displayed:

Custom Name — To make it easier to identify the element instance in the system,
assign the instance a Custom Name. The Custom Name also appears in Chargeback.
For more information, see “Assigning a Custom Name” in the user guide.

Business Cost — The management server lets you assign a business cost to an
application, including virtual applications. This information is used in Event Manager for
ranking events from elements. Event Manager determines the rank of an event by
taking into account the business cost of the application and the severity of the event.
You can sort events by rank in Event Manager by clicking the Rank column. For more
information, see “Assigning a Business Cost to an Application” in the user guide.

Type

Contacted

Record Created
Cluster

Target Operating System
Serial Number
Build Number
Product Name
Version

Discovery Status
Identification Code
Description

Port

Vendor

Name Detected
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= Host - To learn more about the host, click its link.
= Database — To learn more about a database, click its link in the Databases table.

To update the displayed properties, click the Update Element Data button at the bottom of the
screen. The management server gathers new and changed details from the element and then
redraws the topology with the updated information.

Properties of an Informix Database

To find the properties of a database for an Informix instance, follow these steps:

= 1

1. Access Application Viewer by clicking Application Viewer (+""™).
Click the Informix instance in Application Viewer.
Click the Properties tab.

Scroll to the bottom of the page, and click the Informix instance.

o > 0 DN

When you are shown the properties of the Informix instance, scroll to the bottom of the page
to the Database Logical Elements table, and click the database that you want to learn more
about.

The following properties for the database are displayed:
= Description
s Type
= Contacted
= Record Created
» Discovery Status
= Database

= Database Logical Elements — To learn more about a logical element, click its link.

Properties of Informix Database Logical Elements

To view the properties of an Informix database logical elements, follow these steps:

1. Access Application Viewer by clicking Application Viewer (+ il ).

Click the Informix instance in Application Viewer.
Click the Properties tab.

In the Databases table, click a database.

o »~ w0 DN

In the Database Logical Elements table, click the logical element you want to learn more
about.

The following properties are displayed:
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Description
Type

Contacted
Record Created

Chunk Names — The names of the chunks used by the dbspace, sbspace or
blobspace.

Discovery Status
Database

Database Physical Elements — To learn more about an Informix database physical
element, click its link.

Properties of an Informix Database File

To find the properties of a database for an Informix instance, follow these steps:

o > @D

Access Application Viewer by clicking Application Viewer (+ ol ).

Click the Informix instance in Application Viewer.

Click the Properties tab.

Scroll to the bottom of the page, and click the Informix instance.

When you are shown the properties of the Informix instance, scroll to the bottom of the page
to the Database Logical Elements table, and click the database that you want to learn more
about.

In the Database Physical Elements table, click a database file.

The following properties for the database file are displayed:

Type

Contacted
Record Created
Data File Path
Discovery Status
Description

File Path

Database Logical Element — To learn more about the database containing the
database file, click its link.

Database — To learn more about the application, click its link.

Logical Disk
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Viewing Topology for Informix

About the Topology Tab
The Topology tab provides a graphical representation of your storage network.

o Left pane — Provides a path view of the Informix application. When you select an element in
the left pane, its location is shown in the right pane.

¢ Right pane — Provides a logical diagram of the storage network. From the Topology tab, you
can determine the location of a device on the network. For example, you could use the
Topology tab to find which tablespace uses a given data file.

From the Topology tab, you can obtain information about the host, Informix application, Informix
instance, database files, and journal files by double-clicking the appropriate icon in the topology.

When you first access the Topology tab, you are told that the mount points have been filtered.

Note that in the following figure, only one storage volume is displayed. One of the database
instances, sportage_db2, is shown disconnected because its logical drive is not displayed.

Figure 26 Topology of Informix Database with Mount
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To view mount points, click the Filter (E) button in the upper-right corner of the screen. To view
the Filter button, you need to close the left pane. Select the mount points you want to view by
clicking the appropriate check boxes, as shown in the following figure:
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Figure 27 Selecting Mount Points
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You can also select the mount points from the Select menu.

Figure 28 Selecting Mount Points from the Menu
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When you are done selecting mount points, click Apply Filter. In the following figure, all of the
mount points were selected. Notice that all of the database files are now displayed, and the
database instance sportage_db2 is shown connected to its logical drive.

Figure 29 Topology for an Informix Instance with Mount Points
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You can obtain property information by double-clicking a component.

Accessing the Topology Tab
Access the Topology tab by doing one of the following:

¢ Click an Informix instance under the Informix node in Application Viewer, and then click the
Topology tab.
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Or
¢ Double-click an Informix instance in System Manager, and then click the Topology tab.

You can view property information for the item displayed in the topology by double-clicking its
icon.

For more information, see “About the Topology Tab” in the user guide.
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This chapter contains the following topics:
¢ Monitoring DB2 Overview below
¢ Viewing Events for DB2 on next page
e Viewing Properties for DB2 on page 91
¢ Viewing Topology for DB2 on page 95

Monitoring DB2 Overview

Before you can monitor IBM DB2 Server, you must do the following:

e Have the license for monitoring IBM DB2 Server. To determine if your license supports the
monitoring of IBM DB2 Server, see the List of Features.

e Download IBM JDBC driver for DB2 onto <HP Storage EssentialsInstallation
Directory>\JbossAndJetty\servenappiq\lib folder in Windows SE CMS & <HP Storage
EssentialsInstallation Directory>/JbossAndJetty/server/appig/lib folder in Unix SE CMS.

o Create Managed Database User in HP Storage Essentials.

¢ Provide the application instance name, port number, database names and corresponding user
names.

o Discover the application.
For more information, see the installation guide.

The management software for DB2 is a CIM-based application storage management solution that
lets you realize the benefits of storage in a network by more effectively managing your end-to-end
DB2 infrastructure from a single, easy-to-use console. By integrating real time information from
storage devices, network components, servers, and operating systems with the application
database, the management software for DB2 can improve your application's performance,
availability, and reliability maximizing your return on the applications storage assets. To help
simplify the management of your DB2 storage, the management software for DB2 provides
comprehensive topology visualization from the DB2 database files to the mount point to SAN
switches to storage systems. This enables your storage and application administrators to
immediately visualize the interdependency of the infrastructure to the application. You will no
longer need to cross-reference multiple spreadsheets and call multiple people to get an end-to-end
picture. During periods of infrastructure downtime or other times of equipment failures,
infrastructure interdependencies are at your fingertips, so you can make the correct split-second
decisions when you are having issues with the infrastructure.

The management software for DB2 provides deep visibility into each component that makes up
the DB2 application, including DB2 configuration, host configuration, switch configuration, and
storage system configuration. This detailed information is provided at every level.
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The management software for DB2 is built on CIM, Web-Based Enterprise Management
(WBEM), and the Storage Management Initiative (SMI) industry standards for heterogeneous
storage network management. The implementation of these standards allows the management
software for DB2 to support all your heterogeneous storage needs and ensures that your
investments in infrastructure can be leveraged in the future.

Key Benefits
e Improved DB2 database performance
¢ Increased DB2 database availability and reliability
e Maximized return on DB2 storage assets
Key Features
o Database-to-disk topology view
o Standards-based (CIM/WBEM/SMI-S) management platform
o Database-to-disk monitoring
¢ Real-time monitoring of DB2 storage
¢ Web-based global management console

o Ease of installation, deployment, and manageability

Viewing Events for DB2

To view events pertaining to an DB2 database and its dependent elements, such as storage
systems, follow these steps:
1. Access Application Viewer by clicking Application Viewer (+7"™).

2. Expand the node for the DB2 instance database from which you want to obtain event
information.

3. Click Path Events.
The events for the DB2 database and its dependent elements are displayed in the right pane.
The management server provides the following information about the events:

¢ ID - The identification number assigned to the event.

o Severity — The severity level.

o Time —The time the event was recorded.

o Summary Text— A brief explanation of the event. When you click the summary text, the
details of the event are displayed.

For more information, see “Managing Events” in the user guide.
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Viewing Properties tor DB2

Assigning a Custom Name

To make it easier to identify an element instance in the system, assign the instance a Custom
Name. The Custom Name also appears in Chargeback Manager.

All users query the same database, so this name is displayed to others using the software. You
can make them aware of the name by following these steps:

1. Access the Custom Name box by doing one of the following:
o Double-click an DB2 instance in System Manager, and then click the Properties tab.

Or

o Click an DB2 instance under the DB2 node in Application Viewer, and then click the
Properties tab.

2. Inthe Custom Name box, enter a name.

Do not assign a custom name during “Get Topology” or Get Details. You can determine if the

management server is getting the topology or all element details by looking at the label near
the status button.

Keep in mind the following:
= The name must contain 1 to 64 characters.

= The name must begin with a letter. Any character other than the first character can be a
letter, a numeral (0 to 9), or one of the following symbols: dollar sign ($), caret (*),
hyphen (-), underscore (), or space.

= The name is case sensitive; for example, “Element1” and “element1” are different
elements.

3. Click Save.

Properties of a DB2 Instance

To view the properties of an DB2 instance on a host, follow these steps:
1. Access Application Viewer by clicking Application Viewer.
2. Click the DB2instance in Application Viewer.
3. Click the Properties tab.
The following properties are displayed:

= Custom Name — To make it easier to identify the element instance in the system,
assign the instance a Custom Name. The Custom Name also appears in Chargeback.
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Since all users query the same database, this name is displayed to others using the
software. As a result, you might want to make them aware of the name.

= Business Cost— The management server lets you assign a business cost to an
application, including virtual applications. This information is used in Event Manager for
ranking events from elements. Event Manager determines the rank of an event by
taking into account the business cost of the application and the severity of the event.

You can sort events by rank in Event Manager by clicking the Rank column.
n Type
= Contacted
= Record Created
n Cluster
n Target Operating System
= Serial Number
= Build Number
s Product Name
= Version
» Discovery Status
= |dentification Code
n Description
= Port
= Vendor
= Name Detected
= Host - To learn more about the host, click its link.
= Database — To learn more about a database, click its link in the Databases table.

= Update Element Data — To update the displayed properties, click the Update
Element Data button at the bottom of the screen. The management server gathers new
and changed details from the element and then redraws the topology with the updated
information.

Properties of DB2 Database
To view the properties of a DB2 database, follow these steps:
1. Access Application Viewer by clicking Application Viewer.
2. Click onthe DB2 instance in Application Viewer.

3. Click the Properties tab.
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4. Inthe Databases table, click a database you want to learn more about.

The following properties are displayed:

Description

Type

Contacted

Record Created

Buffer Size (Pages)

Default Extent Size (Pages)
Page Size (Bytes)

Log Secondary

Status

Discovery Status

Database - This is database instance name

Database Logical Elements - To learn more about an DB2 database logical element,

click its link.

Properties of DB2 Tablespaces and Primary Logs

To view the properties of a DB2 database logical elements, follow these steps:

1. Access Application Viewer by clicking Application Viewer (+ vl )-

o > 0 DN

Click the DB2 instance in Application Viewer.
Click the Properties tab.

In the Databases table, click a database.

about.

The following properties are displayed:

Description

Type

Contacted
Record Created
Content type
Page Size (bytes)

Extent Size (bytes)

In the Database Logical Elements table, click the logical element you want to learn more
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= Max Size (bytes)

= Increase Size (bytes)
n Status

= Chunk Names

» Discovery Status

n Database

» Database Physical Elements

Properties of DB2 Database File

To view the properties of DB2 database file, follow these steps:

1. Access Application Viewer by clicking Application Viewer (+ il )-

Click the DB2 instance in Application Viewer.
Click the Properties tab.

In the Databases table, click a database.

o »~ w0 DN

In the Database Logical Elements table, click Database Physical Elements to learn more
about.

The following properties are displayed:
n Type
= Contacted
= Record Created
= Data File Path
» Discovery Status
= Description
= File Path
n Status
= Database Logical Element
= Database

» Logical Disk
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Viewing Topology for DB2
About the Topology Tab

The Topology tab provides a graphical representation of your storage network.

o Left pane — Provides a path view of the DB2 database. When you select an element in the
left pane, its location is shown in the right pane.

¢ Right pane — Provides a logical diagram of the storage network. From the Topology tab, you
can determine the location of a device on the network. For example, you could use the
Topology tab to find which database file corresponds to a database. From the Topology tab,
you can obtain information about an item in the topology by double-clicking its icon.

When you first access the Topology tab, you are told that the mount points have been filtered,
incase of multiple mount points.

Figure 30 Topology of DB2 Database

DB2INST2

You can view the mount points in either of the following ways:
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¢ Click the Filter ('E) button in the upper-right corner of the screen. To view the Filter button,
you need to close the left pane. Select the mount points you want to view by clicking the
appropriate check boxes, as shown in the following figure.

Figure 31 Selecting Mount Points
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e You can also select the mount points from the Select menu.

Figure 32 Selecting Mount Points from Combo Box
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Mount Point (2 — 2)
All Mount Points:

When you are done selecting mount points, click Apply Filter.

Accessing the Topology Tab
Access the Topology tab by doing one of the following:

¢ Clicking an DB2 instance under the DB2 node in Application Viewer, and clicking the
Topology menu.

Or

e Double-clicking a DB2 instance in System Manager, and then clicking the Topology tab.
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